
 



ENGLISH 

Q1.Make a Travel Brochure highlighting how varied and charming Punjab and Odisha are! 

Compare and contrast both the cities covering the following points  

The Journey begins from Ludhiana 

Page 1. Contents 

Page 2. How to reach -by air,by road, by train-Travel fare by all the above means of    

transport.  

Page 3. Climate  

Page 4. Best time to visit 

Page 5. Tourist spots 

Page 6. History and Monuments 

Page 7. Famous personalities of selected cities 

Page 8. Bibliography 

Page 9.    Certificate of completion  

Roll no 1 to 8           Bhubaneshwar -Anandpur Sahib 

Roll no 9 to 16         Puri  -Amritsar 

Roll no 17 to 24        Cuttack - Chandigarh 

Roll no 25 onwards    Konark - Patiala          

 

• Note: The above Travel Brochure is to be completed on coloured A4 size sheets 

 ( Minimum 10) 

• Paste pictures wherever necessary. 

• Use coloured pens. 

• Take the printout of the Portfolio shared below and fill it.    

• All sheets  along with Portfolio are to be kept in a file for submission. 

 

 



Guru Nanak Public School 

Sarabha Nagar 

Ludhiana 

 

  

 

 
STUDENT PORTFOLIO (ENGLISH) 

Session 2025-2026 

 

NAME:  __________________________________ 

SECTION: ________________________________ 

ROLL NO: ________________________________ 

ADMISSION NO: ___________________________ 

SUBMITTED TO: ___________________________ 



DISCOVER WHO I AM !!!!! 

 

 

 

 

 

 

I am,______________ Admn no. _____________ 

Class & Section,_________Roll no. _____________ 

Email id. _________________________________ 

My Phone no. is   

My birthday is on 

Blood Group  

Father’s name  

Mother’s name  

Residential address 

 

 

Paste a photograph of 

yourself or make a sketch of 

yourself 



 My family consists of __________________________ 

_________________________________________. 

I love the most _______________________ in my family 

because ____________________________________. 

What are three adjectives your friends would use to describe 

you? (e.g. studious, careful, intelligent) 

__________________________________________

__________________________________________ 

Who in your life inspires you the most? What have you learnt 

from him/her? 

__________________________________________

__________________________________________ 

How do you see yourself ten years from now? 

__________________________________________

__________________________________________ 

  I like my school because  ______________________ 

_________________________________________.  

SWOT-Based Self-Reflection Questionnaire: 

 *Know Yourself Better*  

 Strengths: 

1. Which three qualities do you consider your greatest 

strengths? 



__________________________________________

__________________________________________ 

2. When have these strengths helped you achieve something? 

__________________________________________

__________________________________________ 

  Weaknesses: 

3. What is something you struggle with or wish to improve? 

__________________________________________

__________________________________________ 

4. How do you react when facing a difficult task? 

__________________________________________

__________________________________________ 

 Opportunities: 

5. What opportunities (at school/ home) do you see for personal 

growth? ______________________________ 

_________________________________________. 

6. Which skill or hobby would you like to develop further this 

year?______________________________________

__________________________________________ 

7. What is your aim /goal in life? (Write in one sentence) 

__________________________________________

__________________________________________ 



8. Who can support you the most in achieving your goals, and 

how?______________________________________

__________________________________________ 

9. What actions can you take to work on your weaknesses and 

grab new opportunities?  

__________________________________________

__________________________________________ 

10. What new experience did you embrace this year and how 

did it shape you? 

__________________________________________

__________________________________________ 

 Threats: 

11. What challenges sometimes hold you back from doing your 

best? 

__________________________________________

__________________________________________ 

12. How do you plan to overcome these barriers? 

__________________________________________

__________________________________________ 

 

 

 

 



SOCIAL SCIENCE 
 

Every student has to compulsorily undertake any one project on :- 

 Consumer Awareness (Refer Economics Ch5) 

 OR  

Social Issues 

 OR 

 Sustainable Development  

The project report entails the following requirements:  

1. The total length of the project report should be minimum of  15 & maximum 20  written 

pages (A4 size sheets white or coloured).  

2. The project report should be handwritten or digital by the students themselves and credit 

will be awarded to original drawings, illustrations of pictures, data (table, bar diagrams, pie 

charts, graphs etc.) , maps and creative use of material.  

 3. The project report should be presented in a neatly bound simple folder. 

 4. The project report prepared should be made from eco-friendly products without 

incurring too much expenditure.  

 5. The project report will be presented in the following FORMAT:  

• Cover Page 

• Acknowledgement 

• Contents 

•  Introduction 

•  Content Presentation 

•  Conclusion/Summary 

•  Bibliography 

•  Teacher’s evaluation report 
 

MATHEMATICS 

Do the following activities on A4 size sheets . You can use colour pens etc 

IMPORTANT INSTRUCTIONS : 

1) The following activity is to be done on A4 size sheets for internal assessment for 

September examinations. 

2) The activity is to be performed as per following : 

a) Objective 

b) Pre requisite knowledge 

c) Material required 

d) Procedure 

e) Observations/ Results  



ACTIVITY 

1) To verify whether the given pair of linear equations are consistent or inconsistent by 

Graphical method . 

(a) x-2y= 0 ; 3x + 4y =20 

(b) 2x+ 3y = 9 ;4x +6y =18 

( c) x + 2y = 4 ; 2x + 4y =12 

2) To find trigonometric ratios of 30 degrees,60 degrees and 45 degrees geometrically. 

( Refer NCERT BOOK page number 122 and 123) 

 

 

HINDI 

1. निम्िलिखित विषयों पर  िगभग 100 शब्दों में अिुच्छेद लिखिए।  

क) ग्िोबि िालमिंग- मिुष्यता के लिए ितरा 
ि)  मीठी िाणी के प्रभाि 

2. निम्िलिखित विषयों पर िगभग 50 शब्दों में आकषषक विज्ञापि बिाए।ँ  

क) कोच िंग सेंटर के लिए विज्ञापि 

ि)  'रक्तदाि महादाि'- आधाररत विज्ञापि बिाए  

3. निम्िलिखित समासों का समास विग्रह करते हुए िाम बताइए: 
 यथाशक्क्त ,त्रिफिा,  िन्िी,  ौराहा ,पिंजाब, ििरत्ि, यथाविचध ,यथामनत ,माता -      

वपता,अमीर-गरीब 

4.  'सिं यि पुस्तक' में पाठ-2 ‘सपिों के से ददि' पढ़कर प्रश्िों के उत्तर लििें। 
 

Note: Dear students, do your holidays homework in Hindi notebook only. 

 

PUNJABI 

Note : Do the given work in Punjabi Grammar notebook. 

1. ‘ ਰ ੁੱ ਖਾਂ ਦਾ ਮਹੁੱਤਵ ’ ਅਤੇ  ‘ ਸਮੇਂ ਦੀ ਕਦਰ ’ ਵਵਵ਼ਿਆਂ ਤੇ (200 ਼ਿਬਦਾਂ ਵਵੁੱ ਚ) ਲੇਖ ਵਲਖ।ੋ 

2. ਤ ਹਾਡਾ ਛੋਟਾ ਭਰਾ ਹਰ ਸਮੇਂ ਟੈਲੀਵਵਜ਼ਨ ਵੇਖਦਾ ਰਵਹਿੰ ਦਾ ਹੈ ਅਤੇ ਪੜ੍ਹਾਈ ਵੁੱ ਲ ਵਿਆਨ ਨਹੀਂ ਵਦਿੰ ਦਾ ।ਉਸ ਨ ਿੰ  ਇੁੱ ਕ 
ਪੁੱ ਤਰ ਰਾਹੀਂ ਪੜ੍ਹਨ ਦੀ ਪਰੇਰਨਾ ਵਦਓ। 

      3.ਵਚਤਰ – ਵਰਨਣ  

*  ‘ ਪਰਦ ਼ਿਣ ਦੀ ਸਮੁੱ ਵਸਆ ’ ਵਵ਼ਿੇ ਨ ਿੰ  ਦਰਸਾਉਂਦਾ ਹਇੋਆ ਇੁੱ ਕ ਵਚਤਰ ਲਗਾਓ ਅਤੇ ਉਸ ਬਾਰੇ ਇੁੱ ਕ ਪੈਰਹਾ (50-60 ਼ਿਬਦਾਂ 
ਵਵੁੱ ਚ) ਵਲਖੋ । 

   4. ਪਰਵਸੁੱ ਿ ਲੇਖਕਾ ਡਾਕਟਰ ਦਲੀਪ ਕੌਰ ਵਟਵਾਣਾ ਦੀਆਂ ਕੋਈ ਦੋ ਕਹਾਣੀਆਂ ਪੜ੍ਹੋ। 



ਪਿੰ ਜਾਬੀ ਪੋਰਟਫੋਵਲਓ 

 
GURU NANAK PUBLIC SCHOOL ,SARABHA NAGAR, LUDHIANA 

CLASS –  X 
Note:- Students to take printout of this portfolio and submit it in a clear bag. 

 

  1.ਸਕ ਲ ਯ ਨੀਫਾਰਮ ਵਵੁੱ ਚ ਤਸਵੀਰ ਵਚਪਕਾ  ਕੇ ਆਪਣਾ ਨਾਂ ਵਲਖੋ।  

 

 

 

 

 

 

 

     

  2.ਜਨਮ ਵਮਤੀ_____________________________________________ 

3.ਜਮਾਤ ਸੈਕ਼ਿਨ___________________________________________ 

4.ਰੋਲ ਨਿੰ ਬਰ_______________________________________________ 

5.ਸਕ ਲ ਦਾ ਨਾ______________________________________________ 

  6 .ਕੁੱ ਦ____________________________________________________ 

  7 .ਸਕ ਲ ਦਾਖਲਾ ਨਿੰ ਬਰ________________________________________ 

   8.ਬਲੁੱ ਡ ਗਰ ੁੱ ਪ _____________________________________________ 

   9.ਅਿਾਰ ਨਿੰ ਬਰ_____________________________________________ 

  10.ਵਪਤਾ ਦਾ ਨਾਮ____________________________________________ 

  11.ਮਾਤਾ ਦਾ ਨਾਮ____________________________________________ 

  12.ਫੋਨ  ਨਿੰ ਬਰ  _____________________________________________ 

  13.ਪਵਰਵਾਰਕ ਮੈਂਬਰਾਂ ਦੀ ਵਗਣਤੀ_______________ 



 14.ਘਰ ਦਾ  ਪਤਾ___________________________________________________________ 

 15. ਮੈਂ ਇਹ ਪਸਿੰ ਦ ਕਰਦਾ ਹਾਂ___________________________________________________ 

16.ਮੈਂ ਇਹ ਪਸਿੰ ਦ ਨਹੀਂ ਕਰਦਾ ਹਾਂ________________________________________________ 

 17.ਮੇਰੀ ਤਾਕਤ____________________________________________________________ 

 18.ਮੇਰੀ ਕਮਜੋ਼ਰੀ___________________________________________________________ 

 19.ਮੇਰੀ ਮਨਪਸਿੰ ਦ ਖਡੇ_______________________________________________________ 

 20.ਮੇਰਾ ਸੌਂਕ______________________________________________________________ 

 21.ਮਾਤਾ – ਵਪਤਾ ਬਾਰੇ_______________________________________________________ 

________________________________________________________________________ 

 22.ਮੇਰੀ ਵਜ਼ਿੰ ਦਗੀ ਦਾ ਉਦੇ਼ਿ____________________________________________________ 

_______________________________________________________________________ 

 23.ਮੈਨ ਿੰ  ਡਰ ਲੁੱ ਗਦਾ ਹੈ_______________________________________________________ 

  24.ਮੇਰਾ ਪੁੱਕਾ ਵਮੁੱ ਤਰ _______________________________________________________ 

 

25.ਕੋਈ ਵੀ ਕਵਵਤਾ , ਕਹਾਣੀ, ਪਾਠ, ਇਕਾਂਗੀ ਤ ਹਾਨ ਿੰ  ਪਸਿੰ ਦ ਹੈ,  

ਉਹ ਤ ਹਾਨ ਿੰ  ਵਕਉਂ ਪਸਿੰ ਦ ਹੈ ਬਾਰੇ ਵਲਖੋ।  

___________________________________________________________________________

___________________________________________________________________________

________________________________________________________________________ 

___________________________________________________________________________

___________________________________________________________________________

________________________________________________________________________ 

 

 

 

 



SCIENCE 

CHEMISTRY:    A. Write following practicals in science lab. manual- 

1. To find the pH of following samples by using pH paper    

 (a) Dilute hydrochloric acid 

 (b)Dilute NaOH solution     

 (c) Dilute ethanoic acid  

 (d) Lemon juice   

 (e) Water   

 (f) Dil. Sodium bicarbonate. 
 

 2.  To study the properties of acids ( Dil. HCl) by their reaction with  

(a) Litmus sol. ( Blue / Red ) 

(b) Zinc metal     

(c) Sodium carbonate 
 

3. To study the properties of base(Dilute NaOH) by its reaction with  

(a) litmus solution  

(b) zinc metal  

(c) Hydrochloric acid  
 

4. To perform & observe the following reactions & classify them into :  

(a) Combination reaction 

  (b) Decomposition  reaction 

  (c) Displacement Reaction  

(d)Double displacement reaction 

(i) Action of water on quick lime  

(ii) Action of heat on ferrous  Sulphate  crystals. 

(iii) Iron nails kept in copper sulphate sol.  

(iv)  Reaction between sodium sulphate and barium chloride solutions. 
 

5. (a) To observe the action of Zn, Fe, Cu and Al metals on the following salt solutions. 

 (i) ZnSO4 (aq).  (ii) FeSO4 (aq).   (iii) CuSO4 (aq).    (iv) Al2(SO4)3 (aq). 

     (b) Arrange Zn, Fe, Cu and Al metals in the decreasing order of reactivity based on the   

above results. 
 

6. To study the following properties of acetic acid (ethanoic acid)  

 (i) odour  

(ii) solubility in water  

(iii) effect on litmus   

(iv) reaction with sodium hydrogen carbonate. 

 



7. To study the comparative cleansing capacity of a sample of soap in soft and hard water. 

How to write practicals:   

LEFT SIDE( WITH PENCIL) RIGHT SIDE (WITH BLUE PEN, HEADINGS WITH 

BLACK PEN) 

1. AIM OF EXPERIMENT 

2. MATERIAL REQUIRED 

3. DIAGRAMS 

4.RESULT 

1. AIM OF EXPERIMENT 

2. THEORY 

3. PROCEDURE 

4. OBSERVATION TABLE (IF ANY) 

5. PRECAUTIONS 

B. Revise chemistry syllabus.  

BIOLOGY: 1. Draw the following diagrams in biology note book – 

NOTE :   Diagrams must be neat and well labelled . 

(a) Human respiratory system                                   (b)  Human heart 

(c) Human Excretory system and Nephron             (d) Human brain (Ch.6) 

2. Revise the biology syllabus covered in class. 

PHYSICS:  

1. Draw the ray diagrams for the image formation by concave mirror and convex lens for the 

different positions of the object. Also mention the nature and size of the images formed.  

2. Draw the ray diagrams for the image formation by convex mirror and concave lens and 

also write the range of magnification for the respective image formed. 

3. Revise the lesson thoroughly. 
 

 BANKING & INSURANCE 
 

 PROJECT ON BANKING  

• Introduction Meaning of Negotiable Instruments  

• Features of Negotiable Instruments  
 

CHEQUES  

• Meaning of cheques  

• Features of cheque  

• Types of cheques  
 

BILLS OF EXCHANGE  

• Meaning of bills of exchange  

• Features of bills of exchange  
 

PROMISSORY NOTES  

• Meaning of PN  

• Elements of PN  
Give difference between PN & BE  
Do your project work in plain A-4 size sheets, paste at-least 10 pictures, and submit in clear 
bag only.  
Complete your Notebook. 



  
INFORMATION TECHNOLOGY 

 
PRACTICAL FILE 

 
 

INSTRUCTIONS: 

1. Use only LibreOffice Writer to create your entire Practical File. 

2. Design an attractive Cover Page (with a colourful background) for the 

Practical File, mentioning the Title (Practical File), Subject: Information 

Technology (402), School Name, Academic Year, School Logo, Name of the 

concerned SUBJECT TEACHER, and Student Name, Class-Section. A Sample 

has been provided. 

 

3. The certificate designed in Project 1 will be attached after the Cover Page. 

4. Create an Acknowledgement as given and append it to the Certificate. 

5. Insert Header (IT Practical File 2025-26) and Footer (Student Name, Class-

Section) on all pages of your file from Project 2 onwards. 

6. All Projects MUST be printed on A4 sheets. Submit ONLY coloured printouts. 

Black & White Printouts will NOT be accepted. 

7. Bring the file in a well-labelled clear bag or any other document holder. 

8. Neatly organize the entire project — no spelling/grammatical errors. 

9. Creativity, neatness, and formatting will fetch extra marks.  

 
 
  



 

GURU NANAK PUBLIC SCHOOL 
SARABHA NAGAR, LUDHIANA 

 

 

 

INFORMATION TECHNOLOGY (402) 

PRACTICAL FILE 

2025-26 

CLASS-X 

 

 

 

 

 

 SUBMITTED TO      SUBMITTED BY 
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Student Name 



 

PROJECT 1: DESIGN A CERTIFICATE 

TASK: Create a certificate and write the sample content given below. Design a 
PROFESSIONAL background/frame before typing the content.  

 

 

 

 

 
 
 
 
 

 

 

 

PROJECT 2: IMAGE FORMATTING 
Task: Insert any image. Create its copy and paste it next to the original image. 
Crop the duplicate image to remove the unwanted portion. Demonstrate the 
following image editing tools on the cropped image: 

• Image Resizing 

• Image Rotation 
 

PROJECT 3: DRAWING OBJECTS EDITING 
Task: Insert any three different drawing objects. Give different fill colours and 
line styles to them. Demonstrate the different types of horizontal and vertical 
alignment options. 
 
PROJECT 4: CREATE A PAMPHLET 

Theme: “Holiday Vibes & Study Tips” 
A mix of holiday celebration ideas, time management tips, and light academic 

prep-guides for board exams 
Task: Design an A4-size pamphlet on the topic given above, using all features of 
Libre-Office Writer. A sample has been shared for your reference. Use your own 
creativity. DO NOT RECREATE the sample itself. 
 

CERTIFICATE 
 
 
 

This is to certify that this practical file is submitted by 

………………………………………, (Roll No. ……………………….), to the IT Department of 

GURU NANAK PUBLIC SCHOOL, SARABHA NAGAR, LUDHIANA, carried out by 

her/him towards partial completion of Practical Exam for class X during 

academic session 2025-26. 

 

 

IT Teacher                Principal 



  



 

PROJECT 5: CREATE A REPORT USING STYLES AND TABLE OF CONTENTS 
Title: "Exploring the Beauty of Andaman & Nicobar Islands"  
Task: Create a professional, well-formatted document with the following 
sections: 
 

Contents:  
1. Table of Contents  

• Use the Table of Contents feature from Insert → Table of Contents and 
Index → Table of Contents, Index or Bibliography.  

2. Introduction  

• A short paragraph introducing the State/UT.  
3. History  

• Historical background of the region.  
4. Culture and Traditions  

• Include festivals, languages, traditional attire, and food.  

• Insert relevant images.  
5. Tourism and Places to Visit  

• Top 5 tourist places with small descriptions.  

• Insert pictures and format them with borders.  
6. Fun Facts and Interesting Information  

• Bullet points or numbered list.  
7. Bibliography  

• Mention the sources/websites you used. 
 

Formatting Requirements (Compulsory):  
✓ Use predefined Heading Styles (Heading 1, Heading 2, etc.) 
✓ Apply Font Style and Size properly  

(Title – 18 pt, Bold, Times New Roman, Body – 12 pt, Calibri)  
✓ Insert Images with Captions.  
✓ Use Page Border (Format → Page Style → Borders).  
✓ Insert Page Numbers (Insert → Fields → Page Number).   
✓ Use proper bullets/numbering where needed.  

 

 

 
 

 


